2wz ] Integrated Sclution System
MlDAS clvl for Bridge and Civil Structures

midas Civil 2006 (V7.6.1) Enhancem

Analysis
» Automatic Check for Tendon Stress Limits
* Addition of Cable Efficiency Table

 Addition of Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as
per Eurocode2:04

* Addition of the Time Dependent Material (Compressive Strength) as per CEB-FIP (1978)

» Update on Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as
per IRC:18-2000

* Improvements of the Moving Load Analysis as per IRC: 6-2000

* Addition of distributed springs

+ Addition of Sturm Sequence Check and Load Factor Range option in Buckling analysis

» Improvements on the Eigenvalue analysis considering the maximum number of frequencies
* Transfer reactions of slave nodes to the master node

* Considering buckling load in the Pushover Yield Surface

* Option for ignoring Lateral-Torsional Buckling mode in Buckling Analysis

* Finding Concurrent Forces in Moving Load Analysis as per BS5400

* Nonlinear Point Spring Supports for Construction Stage Analysis

: April, 2009



2wz ] Integrated Sclution System
MlDAS C|V| l for Bridge and Civil Structures

midas Civil 2006 (V7.6.1) Enhanceme

Pre/Post-Processing

* Importing Composite Sections generated from SPC

* Improvements on the display of Supports and Point Spring Supports
* Addition of the Preference in online help

 Addition of upside-down T-shape beam

* Improvements in IS84 section DB

» Save an image in JPG format

* Addition of an export option in result tables

» Export frame model to solid/plate model

* Improvements in Beam Wizard

April, 2009
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Analysis

Automatic Check for Tendon Stress Limits

Upgrade Contents

» The program checks stresses in tendons based on the stress limits specified by the user.

Effects & Usage

* In the Tendon Stress Limit Check table, the stresses in tendons, and the stress limits at the anchorages and elsewhere along the length of the
member are displayed. If the stress in a tendon exceeds the stress limit, the corresponding row is marked in red.
* When numerous tendons exist in a model file, this function is very convenient in checking the stress limits in a spreadsheet table format.

Results > Result Tables > Tendon > Tendon Stress Limit Check

Tendon Stress Tendon Stress Limit TEI'IdDI'I Stress EI
Tendon FDL1 FOLZ FLL Immedistely after andhor set
= = = At zervice
(MAmm=) (Mimm=) (Mimm=) At anch. Awvay from anch. Tendan Stress Limit

L Buat1 8671222 1008 6050 1008 6050 1330.0000 1406.0000 1280.0000
| Biot2 566.9052 1008.4515 1005.4515 1330.0000 1406 .0000 1250.0000 |":"|t anc |-| . I m .l:l:I u
| cs0a01 | 951 7275 1086.9357 1078.3223 1330.0000 1406 .0000 1250.0000

CEital _r 951.9741 105723350 10796144 1330.0000 14060000 1250.,0000 I
| csmabz | 970.9645 10955414 10674911 1330.0000 14060000 12800000 '&'WE S"I frl:l m anc h ' D' B fl:l u

CE01a02_r 9712241 10985414 1087 7895 1330.0000 14060000 12800000 .
: CE01a03_) 952 9554 1103 6489 10954710 1330.0000 1406.0000 1280.0000 &t service I |:|. ] f|:| I
| c=s0Ma03_r 953.2302 11038547 1095.4755 1330.0000 1406 .0000 1250.0000
| cs01kO1_d 9256975 1069.5204 1068.5204 1330.0000 1406 .0000 1250.0000

CE0ThD _r 9256691 10697505 1069.7505 1330.0000 14060000 1250.,0000
| csoteoz 946.5612 1076.5253 10696500 1330.0000 1406.0000 1250.0000 Ok, I Cancel I
| Cs0Mb02_r 9457449 10768016 10699516 1330.0000 14060000 12800000
| csS0MbO3_| 959.790F 107991589 1070.4710 1330.0000 14060000 1280.0000
| CE0MbO3_r 959 9566 1080.2054 1070.7541 1330.0000 1406 .0000 1250.0000
| c©s02a01d 932.7598 10711960 1071 1960 1330.0000 1406 .0000 1250.0000
| cs02a01 ¢ 9328301 1071.3970 10713970 1330.0000 1406 .0000 1250.0000
| cs02a02 | 9530878 10791345 10707337 1330.0000 14060000 12800000
| c=02a02 ¢ 9532380 1079.3454 10709434 1330.0000 14060000 12800000
| ©s02a03 970.7999 1081 .74 1071.2847 1330.0000 14060000 1280.0000
| C=02a03_r 9709601 10581 8655 10715031 1330.0000 1406 .0000 1250.0000
| ©S02k01_1 7815159 990.2175 990.2175 1330.0000 1406 .0000 12800000 o
| cs02p01_r 7820235 99042589 990.42589 1330.0000 1406 .0000 12800000 )
| ©s02h02_| §26.3534 10174450 1017 4430 1330.0000 14060000 12800000
| C=02p02r 526 5675 1017 6609 1017 BEO9 1330.0000 14060000 12800000
| ©S02k03| 8656351 10421207 10424207 1330.0000 14060000 1280.0000
| CS02h03_r 565.5604 10425412 10423412 1330.0000 1406 .0000 1250.0000
| ©s03a01 9323756 107059447 1070.9447 1330.0000 1406 .0000 1250.0000
| ©=03a01_r 9325233 10711613 1071 1613 1330.0000 1406 .0000 1250.0000
| ©s03a02.0 952.9028 1079.5094 1070.7975 1330.0000 14060000 12800000

CE05a02 9535.0611 1079.5400 1071 0235 1330.0000 14060000 12800000

[Tendon Stress Limit Check Table] 3/26
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Analysis

Addition of Cable Efficiency Table

Upgrade Contents

+ Efficiency of inclined cables is computed in the Cable Efficiency Table.

Results> Result Tables > Cable Efficiency Effects & Usage
G Modelvien ) Gi Result-[Cable Efficiency] | Cable efficiency, r, is calculated from the following equation:
giem | Mode 1 node Jf Losd Chord Length Exa& Wizight Tension E = A& (mocd) e

(m) ftonf) ftanf) (tont) itant) (EA)m0 §= r(EC A%)
1 1 2 Lct 16,4888 835600.0000 56951 15626205  B835128.7113 09394
2 2 3 Let 12,8621 335600.0000 44425 15700333 835319.8499 03357 1
3 3 4 Lct 12,9263 §35600.0000 44647 15777526 8353239370 09397 r=
4 4 5 Le 12.9956 B835600.0000 44856 15860333  335325.2402 0.8397 1+ G2 cos® aEC A: [12H 8
5 5 B LCt 13.0701 435600.0000 45143 15949089 8353327475 09357
& & 7 LCt 131496 335600.0000 45413 16043585 8353374455 03357 .
7 7 8 L 13,2342 ©35600.0000 45710 16144276 8353423212 09997 where, G = the total weight of the cable
] ] 8 Lct 13.3237 335600.0000 46020 1625001 8353473632 03357 L = the length of the chord
] 8 10 Lct 13.4163 435600.0000 46346 16364039 8353525609 09357 " :
10 10 11 Lc 135178 335600.0000 46690 16453249 8353578832 03357 H = the horizontal compo.n(.ant of the cable tension, T
11 11 1210 13.1575 @35600.0000 45446 1590108 8353303217 0.9997 E. = the modulus of elasticity
12 12 13 Lo 13.0761 35600.0000 45164 15804509 8353253451 03357 A, = cross-sectional area of the cable
13 13 14 Lo 12,8999 §35600.0000 44301 15714416 8353205967 09357
14 14 15 Lcd 12,8290 §35600.0000 44656 15630816 8353150886 03357 a = the angle of the cable
15 15 16 L1 12,8634 @35600.0000 44430 15553855  835311.8554 09357
16 16 17 LC 12,5032 §35600.0000 44222 15483122 8353078937 09397
1717 18 L 12.7484 435600.0000 44032 15416645 8353042151 03336
18 18 19 Lc 12,6990 §35600.0000 43852 15360383 8353008378 03396
19 18 20 L 126550 335600.0000 43710 15308305 8352977753 03338
2 2 21 Lo 12,6165 §35600.0000 43577 15262386  B835295.0402 03396
2 A 2L 12,5835 335600.0000 43453 15222607 8352926441 03395
= 22 23 L0 12,5558 §35600.0000 43357 15188950 8352905578 03396
23 23 24 L 12,5338 335600.0000 43231 15161454 8352859120 03395
24 24 251 12,5173 @35600.0000 43234 15140206 835267 6002 09336 . .-
25 25 26 Lo 12,5062 335600.0000 43196 15125421 8352866836 03395 Only cable elements can be checked in Cable Efficiency table.
® 27 L 12,5008 835600.0000 4377 15117641 835206.1898 03396
2 2L 12,5008 335600.0000 43177 1511764 8352861893 03395
2 2 2910 12,5062 §35600.0000 43196 15125421 8352066836 03396
29 28 30Lc 12,5173 35600.0000 43234 15140206 835287 6002 03395
30 W L 12,5338 @35600.0000 43281 15161454 835288.9120 03336
M3 32 Lo 12,5558 35600.0000 43357 15158950 8352905573 0.9395

[Cable Efficiency Table]
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Analysis

Addition of Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as per Eurocode2:04

Upgrade Contents

» Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as per Eurocode2:04 is newly implemented.

Model > Properties > Time Dependent Material(Creep/Shrinkage)
Model > Properties > Time Dependent Material(Comp. Strength)

Load > Prestress Ioads > Tendon Property 9 Com press've Strength AddiModify Time Dependent Material (Comp. Strength)
Name Sealls Fattor Graph Options

Eurocods2 [ ¥-aislog scdle: [ Y-aislog scdle:

Type
@ Code

© Creep/Shrinkage

Development of Strength

Code: [Furopean M

i *N)xexp[gxb,(z ! 5})

Add/Modify Time Dependent Material (Creep f Shrinkage)

Mezn compressive strength of concrete:
Name ; |Eur0c0de Code: |(ENgafalsE af the an oF 76 s frkdeba £

0 Hjmm?

European

Characteristic compressive cylinder strength of concrete at the 40 Mimm? Cement Typels)
age of 28 days (Fck) : Class 12 0.25

Relative Humidity of ambient environment {40 - 993 70 %
0: a6 s L o a2 oz

Mokational size of member 1 i Tine (day)

h=2*aciu (Ac: Section Area, u @ Perimeter in contack with atmosphere)

Reda Grash

Type of cement
" Class 5 * Class i " Class R

Type of code \

" EM 1992-1 {General Struckure) N
\ Add/Modify Tendon Property. E|

& EN 1992-2 (Concrete Bridge) [~ df siica-Fume ® Tendon Loss P
Tendan Type

- . 3 P e N
Ane of concrete at the beginning of shrinkage : o day T — kendan
= Show Time Dependent Material Function Tendon Type Internal(Post-Tension) -

Shaw Result Creep Function Data Type Graph Options Makerial 4 #: tendan i |
I %-axislog scale [ V-axis log scale 206,13 P Jom

= Lreep Coefficiert; Total Tendon Arsa

Duck Diameter 50 m
Start Loading 10 Day [¥ Relaxation Coefficient European S
End Loading 10000 Day
Mo of steps (26 Ultimate Strength 18123 Himm?
Curvature Friction Factor 0.3
Time - A
ay) ale Wobble Friction Factar 2.2¢-005 tmm
1254 R External Cable Mameni Madnifier Nimm?
1778 3.2520e-001
2371 4.0133e-001 Anchorage Sip(Draw in) Bond Type
3162 46362e-001
4217 533568001 Bean : [3.6 n (+ Bonded
5623 5.946de-001 F  Unbondsd
i | nbonde:
7499 653548-001 fd i
10000  7.1051e-001
13335 7 6556e-001

Redraw lose: OK Cancel

Creep Coefficient

1000 esoo 4000 sson 7eoo  ase 10000
Tiue(day)

t




Integrated Solution System

MIDAS Cl VIl For Bridge and Civil Structure

Analysis

Addition of the Time Dependent Material (Compressive Strength) as per CEB-FIP (1978)

» Time Dependent Material (Compressive Strength) as per CEB-FIP(1978) is newly implemented.

Model > Properties > Time Dependent Material (Comp. Strength)

Add/Modify Time Dependent Material (Comp. Strength)

Mame
|cEB-FIP{1975)

Type
+ Code

Development of Strength

Scale Factor

o

Graph Options

[ ¥-axis log scale [ ¥-axis log scale

Cade: |CEB-FIP{1978)

Petmanent camprasive strength (Fooo)

43 Ijrnim?

Q 100 200

00 400 500 E00 700 00
Time [day)

Redraw Graph

Cancel

2009 Upgrade

Upgrade Contents

Note. Time Dependent Materials based on CEB-FIP
are supported by midas Civil as shown in the table

below.

ltems

CEB-FIP (1978)

CEB-FIP (1990)

Creep

Available

Available

Shrinkage

Available

Available

Comp.
Strength

Available

Available
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Analysis

Update on Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as per IRC:18-2000

Upgrade Contents

+ Time Dependent Material (Creep/Shrinkage, Compressive Strength and Tendon Loss) as per IRC18:2000 is newly implemented.

» Creep function can be shown as “creep strain per 10MPa” as well as “Creep Coefficient”.

Model > Properties > Time Dependent Material(Creep/Shrinkage)
Model > Properties > Time Dependent Material(Comp. Strength)
Load > Prestress loads > Tendon Property

® Compressive Strength
Addeodily Time Dependent Malerial (Camp. Sreaglh)

Harme

(=23

Tree
v Code

Durvekoprani of Siswngth

O Creep/Shrinkage o [Pt 200
Add/Modify Time Dependent Material (Creep / Shrinkage) X T

Conmeta Conoressive Srenath =t 28 Cews [T28)

Mame: [IRC18-2000 Code:  |INDIA(IRC: 18-2000) |

i e
IMDIACIRC § 18-2000)
Compressive strength of concrete at the age of 28 days ; 40 Mimm? vt HR

Tine [dey)

—
Relative Humidity of ambient environment (40-990 ; v

Motational size of member : 1 Y/ ® Tendon Loss

— =k . : . . f A
h=2%*fc/u (Ac: Section Area, u: Perimeter in cor’ k with atmosphere . Add/Modify Tendon Property X
Show Time Dependent Material Function 3 —
Age of concrete at the beginning of shrinkage D ——— Tenden Type
— i 4 is log scale Tendon Mame tendon
& Shrain/10MPa ¢ Cosff ‘ X -
ILEFERSE Creep Function Data Type Tendon Type Internal{Past-Tension) =
I—l | P [ o]
Shows Resulk, . Start Loading : (e 4 tendon
296.13 P o

End Loading : /10MPa ¢ Coefficient Total Tendon Area
MNum, of Steps : Duct Diameter S0 o

v Relazation Coefficient [motairciis-200 < | rormal |
Ukimate Strenath 19123 -
Curvature Friction Factor R

‘Wobble Friction Factor [zzenos  tmwm
External Cable Moment Maanifier ]7 fmm?
Anchorage Slip(Draw in) Bond Type

T Bean : [3.6 D &+ gonded
+ T = T T T — T 1 3 o ¢ Unbonded
0 1000 2500 4000 SS00 7000 8500 10000 :

Time (day)

#

Time

> e : 3
A Y

Creep - Strain/l0MPa (x B

AR AR

|

EEEERRERERERE!

<

4 R1N3e-

Redraw Close

0K Cancel
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Improvements of the Moving Load Analysis as per IRC: 6-2000

Upgrade Contents
User-defined Live Load Combinations, using both standard vehicle loads and user-defined vehicle loads, are newly implemented.
User-defined Impact Factors for Traffic Line Lanes are newly implemented.
The auto-calculated Impact Factors or user-defined Impact Factors can be checked in the *.OUT file.

Effects & Usage

The user can perform Moving Load Analysis by user-defined Live Load Combinations. The user can define a specific live load combination, and
check the member forces obtained from the combination quickly and easily. This feature significantly reduces work-time when performing Moving
Load Analysis. (Please refer to overleaf example.)

Load > Moving Load Analysis Data> Traffic Line Lane, Moving Load Cases
Tools > Text Editor

Define Design Traffic Line Lane [ Define Moving Load Case Sub-Load Case _ & MIDAS/Text Editor - [4Bm-Box Girder....

B v wa— "
Lanetame s 11 Bl Ele Edt view Window Help

Traffic Lane Properties el & el L] Case Dt
= B =l
Description ; Scale Factor = == EL g By =
P o118 IMPACT FACTOR  (T=AUTO CALCULATION, F =
—_!— Auko Live Load Combination Min. Mumber of Loaded Lanes : < koo FACTORA o CLASS A& CLASSE FACTOR o R L~
Mulk %, Nurmber of Loaded Lanes @ = 001 20

f P - o121 LANE 1
f* Impact Factor : 0.z mmf | Aubo Live Load Combinakion P e I bei. e o, FACTOR FACTOR2 FACTORS

1 o123
(" Span Length : 3 C— boizd 000 F 010000 040000 010000

Assign Lanes 00125 033 020000 0.20000  0.20000

4 0.3 101 26 07a 020000 0.20000 0.20000
vehicular Load Distribution

List of Lanes Selected Lanes o127 020000 0.20000 0.20000

F

F

F

& LaneElement  ( CrossBeam =5 0.8 L1 . F
Cross Boam Group L3 > o128 B7 F 020000 0.20000 0.20000
] o1 29 00 F 020000 0.20000 0.20000
s Mumnber of Loaded Lanes E| 1001 30 5 F 020000 020000 0.20000
s [} Impact Sub-Load Cases potst 68 F 020000 020000 020000
e MO Elem oot 22 01 F 020000 020000 020000
o 2 Factor Vehicle [ Scale  [Lanet [ Lanez == o133 34 F 020000 020000 020000
oo Class 40R. 1 Ll 01 34 68 F 020000 0.20000 020000

Boo] 0.2 Clssa 1 12 13 Lo i

36 F

B9 F

F

F

020000 020000 020000
) 0.2 Class 70R 1 L L ot 30 020000 0.20000 020000
2 . pot37 020000 020000 020000

OK | Cancel | apply

00128 020000 0.20000 020000

——] | 5

E;' nz > ke ; 020000 020000 020000 Jﬂ
J‘ i Modify Delete J‘_l_' L4

2] 2 - 0.2

| 3 ] B Ready

4 e Cancel ‘ Apply |

[Output of Impact Factors in the *.OUT file]
[User-defined Impact Factor] [User-defined Live Load Combinations]

8/26
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Example: Improvements of the Moving Load Analysis as per IRC: 6-2000

l Procedure I

This example introduces how to define a specific
Live Load Combination as shown in the figure 1.
The user can consider this specific case by

defining Moving Load Case as described below.

o
2]
©
(4]
(5]
(o)
o
(&)
o)
®
®
®

After defining 5 Traffic Line Lanes and 2 vehicles
(Class 70R and Class A), Click Load> Moving
Load Analysis Data> Moving Load Cases.

Click Add.

Enter the Load Case Name and Description.
Unselect Auto Live Load Combination* option.
Click Add

Select the Class 70R vehicle and select the
Min./Max. Number of Loaded Lanes as 2

Select the Lane 2 & 3 and click > |
Click OK.
Click Add.

Select the Class A vehicle and select the Min./Max.

Number of Loaded Lanes as 1
Selectthe Lane 5 and click - |
Click OK.

*Note. Auto Live Load Combination

Select this option to define the Live Load
Combinations according to the clause 207.4. of
IRC: 6-2000. Unselect this option for user-
defined Live Load Combination.

| Class7TOR .

Class 7T0R Class A

L

Lane 2

[Figur

Lane 3 Laned
e 1. Example of vehicle loads]

(~Load Case Data

Load Case Mame :

S Lanes_takel

Scale Fackor

Descripkion :

|2_CIass?DR_and_1 _Classa

Min. Number of Loaded Lanes :

Max, Humber of Loaded Lanes :

¥ Auto Live Load Combination

Class 70R. - J

1-2

=5

Sub-Load Cases

Mum of Loaded Lanes

Multiple Presence Factor

Mumbet of Loaded Lanes

Scale Factor

Vehicle ;

er Assign Lanes

List of Lanes

Selected Lanes

Lane 2
Lane 3

=
[=]

Lane 1
Lane 4
Lane 5

e oK I Cancel | Apply

2009 Upgrade

Moving Load Cases

Load Case [ Description

Modiy

Delete

b-Load Case

@ Load Case Data

Scale Factor
Min, Mumber of Loaded Lanes :

Max, Mumber of Loaded Lanes :

Class & - J

Wehicle :

@*Asslgn Lanes

List of Lanes Selected Lanes

Lane 1 Lane 5
Lane 2
Lane 3

Lane ¢

=
[=]

@ [a]4 I Cancel | Apply

vehicle Scale

|Lanel

<

oK

o Al | Madfy |

Cancel

[Figure 2. Moving Load Tracer]
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Addition of distributed springs

Upgrade Contents

Distributed springs on the beam, plate and solid elements.

Generate surface springs to represent the stiffness of the soil.

Consider accurate boundary conditions when modeling members on elastic subgrade.
Compression-only spring can be considered.

Model > Boundaries > Surface Spring Supports

N

= = -
Mode | Element Boundary: | Mass | Load T MDdE""'EW/‘-H Result-[Reaction] l

= J Element Type S“”f&?”” Elemert ‘ Load ‘ Mode & Part | ?;i?ﬁ)n D'Spéfncrﬁ;n et
PLATE Planar(Face) c 0.000000 0000000

PLATE Planar(Face) Lct 0000000 0.000000
PLATE Planar(Face) Lct 0000000 0000000
PLATE Planar(Face) Lct 0000000 0000000
PLATE Planar(Face) Let 0007173 -0.7H482
PLATE Planar(Face) Lct 0031848 -3.247630
PLATE Planar(Face) Lct 0010773 1.088570
o PLATE Planar(Face) Lct (0006456 0558316
PLATE Planar(Face) Lct 0007173 0731482

v PLATE Planar(Face) Let 5 0006456 0653316

| (+ Distributed Spring Displ f Distri rf rin r PLATE Planar(Facs) 3 Lt 12 0010773 1.098570
[ Sp ay 0 St bUted Su ace Sp g SquO ts ] 4 | 3 |\ Feaction[Global] ;( Reaction[Local] ,\Heaclion[Local-Sul[ace Spring] § 4

[Reaction (Local-Surface Spring) tab]

|SurFace Spring Supports
Boundary Group Mame

|DeFault ﬂ J

Surface Spring

" Convert to Modal Spring

_» |

*Note. Difference between “Convert to Nodal Spring” and “Distributed Spring”
A ? Distributed Spring Ares When Convert to Nodal Spring is selected, springs are entered at the nodes of the
K £ Moauus of Subgds Resotion elements. When Distributed Spring is selected, springs are uniformly distributed
Element Selection on a face or edge of the elements.

Tvpe : Frame -

Selection: & Element Convert to Nodal Distributed Spring

P . . .
Local Axis Local z - " l Sprlng (Wlnkler Sprlng)
3

1 i L.
Width : m Spring Nodes of Distributed on the elements

% 555555555 location elements

Spring Properties Unit of kN Beam: kN(kN/M)

. N 2
ToEas T M W reaction Planar or Solid: kN(kN/MZ2)
Modulus of Subarade Reaction : Concentrated at As element stiffness increases,

T tfwe (a) Convert to Nodal Spring ) Distributed Spring Deformation the nodes deformations are distributed
throughout the elements.
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Addition of Sturm Sequence Check and Load Factor Range option in Buckling analysis

Upgrade Contents

» Sturm Sequence Check option for detecting any missed buckling modes and Load Factor Range option for setting the range of the buckling load
factor have been newly added.

Analysis > Buckling Analysis Control

Buckling Analysis Control E| ENTEY EIGENVALUE ANALYSIS

Bucking Mades EIGEN S0LUTION : LANCZ0S METHOD

LINEAR BUCKLING ANALYSIS

MULTI-FRONTLL SOLUTION HAS BEEN COMPLETED.

Load Factor Range THERE ARE 10 EIGENYVALUES BETWEEN 0.9123 AND g91.2190

EIGENVALUES HAVE SUCCESSFULLY PASSED STURM SEQUENCE CHECE
MULTI-FRONTLAL SOLUTION HiS% BEEN COMPLETED.

" Search | From: |1 MODE SHAPE OUTPUT.

To: ’10007 DISPLACEMENT/FORCE /STRESS OUTPUT FOR EACH MOLE.

Mumber of Modes

™ Positive Yalus Only

[Message window]
v Sturm Seguence Check

Frame Geometric Stiffness Option

M| o=y =) Favee Ol ﬁ IModel \u'iew/y‘.iil Result-[Buckling Mode] l

Buckling Combination

Load Case : Load Pz | .. I : | BUCKLING
ll— | Mode Eigenvalue Tolerance
Scale Factor i | ! 471.201 2.4954e-009

483422|  30508e-003
506201  3A989e-010
532748  1.2758e-003

: s 570887 |  5&727e-003
Load Pz 1 warisble o { | ! 613777 | 542832003
i 670032  B5623e-010
731385  26047e-008
B0B529|  24969e-007
891218 4 F3z3e-003

Load Type % Variable © Comstant

Load Case | Scale | Load Type |

dd modfy | Delete | [Buckling mode shapes]

[Buckling mode shapes]
Remove Buckling analysis Data |

oK | Cancel |
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Improvements on the Eigenvalue analysis considering the maximum number of frequencies

Upgrade Contents

* When the Number of Frequencies exceeds the maximum number of eigenvalues for a corresponding structure, the program automatically updates
the number of frequencies. In the old version, error message was displayed and analysis was terminated.

Analysis > Eigenvalue Analysis Control

Eigenyvalue Analysis Control @ O Old version

Type of &nalysis

 Ritz Vectors ERROR : NUMBER OF NON-ZERO MASSES REQUIRED
: NUMBER OF EXISTING MASSES IN THE MODEL
 Subspace lteration J0B WILL BE TERMINATED.

" Lanczos

Eigen Yectors - ||ERRORS ENCOUNTERED. MIDAS JOE TERMINATED. REFER TO .0UT FILE
L

Eigenvalue Control Parameters

Murnber of lterations : 0 =

Mumber of Frequencies : |15 =

Subspace Dimension : 1] :

® Ver.761
= =

i T —— ' . ENTRY LOAD_BLOCK
Search From : [cps] Convergence Tolerance : |1e-006 e L o4
To: [— : [cps) ENTRY ASSM_STIFF_LOAD ( FORM GLOBAL EQUILIERIUM EQUATIONS IN BLOCKS )

ENTRY EIGENVALUE ANALYSIS

Rernove Eigenvalue &nalysis Data | OK | Cancel ] WARNING : THE NUMBER OF WON-ZERO MASSES REQUIRED
THE NUMBER OF EXISTING MASSES IN THE MODEL

_4. 'ﬁi Start Page ]’fi Model Yiew /V fi Result-[Eigenvalue Mode] ]

Node | Mode X Uy Uz R R
| EIGEMNY ALUE AMALY
Frequency il Period
{rad/sec) | {cycle/sec) {zec) | |
42567 0.6775 X T.5425e-016
79076 1,2585 2,2727e-016
23,8602 37975 0,0000=+000
59,4587 89,4633 | £.4312e-016 |
111,2854 17,7132 5.8740e-016
195,3672 31,1923 | 7.5770e-016
302,4954 48,1436 '3,1606e-016
350,0455 55,7115 | | 237526016
E30,5500 100,3599 | 1,4639e-016
1 94,2793 110,4950 9,6605e-016

IBD \Eigenvalue Mode 4 Farticipation Vector Mode  f

Talerance
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Analysis

Transfer reactions of slave nodes to the master node

Upgrade Contents

+ Inthe old version, reactions were produced at the master node only when rigid links were assigned. In Civil V761, the user can select if reactions of s
lave nodes are transferred to the master node or not.

Analysis > Main Control Data > Transfer Reactions of Slave Nodes to the Master Node

Main Control Data [Selected]
[V Auto Rotational DOF Constraint for Truss/Plane Stress/Solid Elements When reactions of slab
nodes are transferred to

v Auto Normal Rotation Constraint for Plate Elements the master node
Tension / Compression Truss Element (Elastic Link / Inelastic Spring)

Mumber of lterations/Load Case |20 e
Convergence Tolerance |U.DUI

[~ Consider Section Stiffness Scale Factor for Stress Calculation
|17 i[ranster Reactions of slave Nodes to the Master Node: |

[Unselected]

| oK | Cancel
I When reactions of slab

nodes are not transferred
to the master node




2009 Upgrade

Integrated Solution System

MIDAS Cl VIl For Bridge and Civil Structure
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Considering buckling load in the Pushover Yield Surface

Upgrade Contents

+ In the pushover PMM hinge properties, buckling load can be considered by checking on the ‘Calc. Yield Surface of Beam considering Buckling’

option.
Design > Pushover > Pushover Global Control

Pushover Global Control
Monlinear Analysis Option

Initial Load
Load Case DL - Scale Fackar |1 ¥ Permit Convergence Failure
Mazx, Mumber of Substeps

Skatic Load Case | Scale | dd
= Maxirnurn Ikerakion

DL 1
Modif
LL 0.25 oy Corwvergence Criteria

Iv Displacement Morm
| Force Morm
| Energy Morm

Pushover Hinge Data Option
Default Stiffness Reduction Ratio of Skeleton Curve Data for Auto-Calculation of Strength
Trilinear { Slip Triinear Type Reference Location only For Distributed Hinges
(+ i) Eeam I-end j

|w  Swmmetric

al ot .1
a2 |0.0s |p.os

[~ Calc, Yield Surface of Bearn considering Buckling

Bilinear | Slip Biinear Tvpe
|w  Swmmetric (+) ()
al  |o.os |p.0s

QK | Cancel

Remove Pushover Global Contral
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Option for ignoring Lateral-Torsional Buckling mode in Buckling Analysis

Upgrade Contents

» midas Civil considered Lateral-Torsional Buckling mode in any case. The Frame Geometric Stiffness Option is newly implemented to ignore the
Lateral-Torsional Buckling effect in Buckling Analysis.

Analysis > Buckling Analysis Control

Buckling Analysis Control

Buckling Modes

MNurber of Modes

Load Factor Range

" Positive Yalue Only

{* Search From: |1
To: 1000

Frame Geometric Skiffness Option

v Sturm Sequence Check

[v Consider Axial Force Qnly

Frame Geometric Stiffness Option

Iv Consider Axial Force COnly I

Buckling Combination

Load Case & Load Pz 1 | oo
Scale Factar 1

Load Type : {* Variable  Constant

Load Case | Scale | Load Type |
Load Pz 1 Wariable

Modify | Delete |

Cancel |
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Finding Concurrent Forces in Moving Load Analysis as per BS5400

Upgrade Contents

» Moving Load Analysis considering Concurrent Member Forces is newly implemented.

Analysis > Moving Load Analysis Control
Results> Result Tables> Beam> Force

Select Moving Load Code _ 4 & Model \u'iew/y‘.ijLil Result-[Beam Force] l
. s Axial Shear-y Shear-z Torsion Moment-y Moment-z
fenglezdtaias B [ Blem | Load | Part (k) (kM) ‘ (k) ‘ (it m) ‘ (khbm) ‘ (khbm) ‘
cancel | » 1 MVCI(ma 1) 000 111 4522 780 9838 1005
2 MyLI(ma I[2] 000 &.54 19.58 14 56 26273 518
3 MyLI(ma I3 000 13.47 3325 2171 37840 4352
3 4 MyLI(ma I4] 000 1540 4697 5712 35793 7573
Moving Load Analysis Control Data §| 5 MvLi(ma  I[5] 0.0a 550 5282 7337 26493 10.23
— & MyLi(ma  I[6] 000 153 4816 5072 256 54 4104
Influence Generation Method — ; m:j Ema :{;} g-gg 1?-:; gg-gg L H A8 AL,
ma | K . . i
& Number/Line Element. : 3 = 9 MvLi(ma (9] 0.00 9.40 3817 Result View ltems E'
10 MYLitma  I[0] 000 113 52 68 i )
(" Distance betwesn Points ; 11 MYL1(ma 2] 343 46 0.00 744 Ttems ko Display Load Cases to Display
12 MYLima 3] 375 60 0.00 504 axial [(IDead Load(sT)
Analysis Resuls | 13 mviima 4 38158 0.00 5 86 [C|Shear-y [Jsidewalk Load{ST)
Y 14 MyLigma 5] asd [Ishear-z [IMymasMyLIMy2E(5T)
Plate Frame T 15 wviimma g =5 Copy Tarsion ML 1 (M all)
" Center £ Mormal 16 MYLIgma I[7] 383 v LAMYLI{MY:max)
e . [ Moment-z [ IMYLL{MY: min)
= dal . | 17 MyL1(ma 18] 382 Find. .. LB CE:all
* Center + Moda * Mormal + Concurrent Force | 18 MvL1(ma 9] 375 CILCB1(CE ma)
) i 19 MYLitma (0] 342 ) . [CILCE (B min)
[ Combined Stress Calculation 20 MYL1(ma IM] 1823 Sorting Dialog. .. [CLEB2(CE)
21 MYLitma  I[12] 1856 [CLCE3(CE)
22 MvLigma  [13] 1814 Style Dialog. .. [CILCB4{CE)
Calculation Filkers 23 MyL1(ma  I[14] 1775
[ Reactions I ] it Show Graph...
25 MYLi(ma  I[1E] 1709
oAl " Group : 26 MyLima  I17] 1826 < Cancel
i | I (] 1y Activate Records. ..
v Displacements 28 MyLima  I[19] 2009 - 5885.20 4 \
@ al © Group : 28 MYLi(ma  I[20] 2126 Export ko Excal... 446095
a0 MyLitma  I[21] 0 9838 11
[V ForcesMamenits 3 MyLitma 122 0 q 26273 &
& al ~ 32 MYLA(ma I[23] 0 Wi b""' Load Cases... 37540 44
v A Group a3 MYLima  I[24] 0 ) |
T s wvLimma 25 i Wigw by Max Walue Item... | e
a5 MyLi(ma  I[26] [ix ; - AN " B4
ok | Cancel | 36 MvLi(ma  I[27] 0.00 15.71 3550 5798 ™
a7 MyLitma  I[28] 000 13.42 7293 2113
eam rorce
«T» |\ Beam Force / [«
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Nonlinear Point Spring Supports for Construction Stage Analysis

Upgrade Contents

» Nonlinear Point Spring Supports can be included in Construction Stage Analysis (Comp. -only, Tens.-only and Multi-Linear type)
Model > Boundaries> Point Spring Supports

Node | Element Bu:uunu:l...| Mass | Load |

|PDint Spring Supports j J
Boundary Group Mame

|DeFauIt j J

Opkions
f* add  Replace  Delete

Point Spring {Local Direction)

Type |C0m|:u.-u:unl\,-' ﬂ
Linear

Tens.-only
Mulki-Linear

T

Ty

Stiffmess |0 ki

Direction |Dx{+]| ﬂ

Apply |
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Importing Composite Sections Generated from SPC

Upgrade Contents

» Composite sections can be generated, and parts of these sections can be defined in midas SPC for construction stage analysis.
+ Composite sections generated from SPC can be exported to midas Civil.

I Effects & Usage

» Various types of composite sections can be applied to construction stage analysis.

Model > Properties > Section
Load > Construction State Analysis Data > Composite Section for Construction Stage

> [Before composite action (Part 1)]
Tools > Sectional Property Calculator

¥ o FEE ¢ B reor el

=0 Closed Lap
& Traniate

45 =t § F000

+ &

' Gcala Line
== Change ¥idih
Pick

a o s comitn
I Generate Consvuction Siage Analysis [ B
. Rl : |

T A— M
P 64560 aiaan e e s

Query
= 1@ 5wl Desian Group
Creatn 5., Group
7. Doty 5.0, G
7 Add 5.0, Group
£ Femo tram 5.0, Groun
= TF Compashe Secian
F Generate Composits
Comemnite
Deiets Compoeda HIDRS/SPG § 1.5.8 - Sectivmal Property Galeulator
e Bt Comasiiie PG roject is retrieves from (03000 MUPKIE_O0_UCYRZ_Testwes_ _urt.spel.
- Sectiom [2], Curue [49], Peint [70]

e EIE (113 Lo
E @ R ER e XD ONNED | OE |+ @k +U-ZT=X S+ ER
s

$ e 0008 mA et [

TN T

P B e e s— Loty 9
T — z o ARG S S =] R o] T

[Composite Section in SPC] [Before composite action (Part 1+2)]
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Improvements on the Display of Supports and Point Spring Supports

Upgrade Contents

» A new feature that displays the Support and Point Spring Support offering an intuitive way of identifying boundary conditions.

Model > Boundaries > Define Constraint Label Direction
View > Display > Boundary

Display

Load ] Wiga ] Design
Node ] Element ] Prapetty Boundary l Misc

fe Al Group Selection

Suppotk o

Support by Direction | 1
[JPoint Spring Support:
[ JPoint Spring Support (CompfTens)
[ |Paint Spring Support (Mulki-Linear)
| |Paint Spring Suppart by Direction {1
[ |Paint Spring Suppart by Direction{Comp) Tens) ¥ g < R BDund”" e ;
BEE:’?;ESEI;E?II?;EEET;:DEE E;LB;UDH(MUWI-LIHBBF) / |Dafine Constraint Label Direction j
| 15urface Spring Support (Linear) e
[ |Surface Spring Support (Caomp. i Tens.)

Ceneral SprnG SUpPON 1 + Add/Replace; " Delete
EE:aSE!C II:!HIIZL | B Label Direction

lastic Link Local Axis g

[CIElastic Link Type [Example of Label
[JElastic Link Number . . tocelx Direction — Box Culvert]

e . i Local ¥

Local z

[ Display by Group | & . -
[ Display by Selection Iv Display by Member )
[ Hidden Labels

011000 =

Display Option Reset Al ‘ 4
| [Define Constraint Label
[Point spring support] [Support] _wy | _gose | Direction]

Cancel Apply
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Addition of the Preference in online help

Upgrade Contents

* The user can select a Local Help or Web-based Help in the preference.

* When ‘Use Local Help’ option is checked on, a Local help file (CVLw.chm) which has been installed in the local computer is invoked by pressing ‘F1’
key.

» Default setting is check-off, which invokes a Web-based Help. Since Web-based Help can be frequently updated, default setting is recommended.

Tools > Preferences > Environment

Preferences @

= Environment
G_eneral
< Views v Show Motice
-Data Tolerances
- Property [T~ Use Local Help |
Load
-Results

- Design
| Motice & Help
raphics

=~ Output Formats
-Formats - Dim, & Others
-Formats - Forces
Formats - Loads

v &ave Changes Upon OK: Default All | Set Default “ OK I Cancel

[Web-based Help]
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Addition of upside-down T-shape beam

Upgrade Contents
» Generate the strip foundations using upside-down T-shape beam.

» Both upside-down T-shape and L-shape section can be generated.

Model > Properties > Section
Tables > Structure Tables > Properties> Section

Section Data Section Data

DBfUser ] DE/User ]Value ] SRC ] Combined ] Tapered]

| J_ Upside-Down T-Section j Sectian ID |1 | J_ Upside-Down T-Section

Mame  |T100-150-60-40 * User " DB Mame |L1O0-60-50-40 & User ~ o8 l—_|

SectionID |t

Sect, Mame Seck. Mame

M W

W Consider Shear Deformation. v Consider Shear Deformation,

Offset:  Center-Center Offset :  Center-Center

Change Offset ... Change Offset ..,

| Show Calculation Results... | | Cancel | Show Calculation Results... | Ok Cancel

[Upside-down T-shape section] [L-shape section]
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Improvements in 1S84 section DB

* In 1S84 section DB, H-Section and Channel now reflect ‘r’ value.
» T-Section has been newly added as per 1S84.

Model > Properties > Section

Section Data

DEUser l\n'alue ] SRC ] Combined ] Tapered]

Section 1D |1 ‘I I-Section j
Name [[100-600-60-40  ~ yser @ DB Isa4 hd
Sect, Mame s 100] 2
-

H ,7 mm

Bl ’7 (i

b ’7 (am

tFi 2 mm

B2 ’7 (i

tf2 [ mm

rl | mn

r2 ’7 min

¥ Cansider Shear Deformation.

Offset : Center-Center

Change Offset ...

%

Show Calculation Results. .. | Cancel Apply

Section Data

DBj{lser l\"alue | sRc | Combined | Tapered |

SectionID |1

| T T-3eckion -
Mame |L100-600-60-40  User = DB

Sect, Mame

v Cansider Shear Defarmation,

Cffset:  Center-Center

Change Offset ...

Show Calculation Results... | Ok | Cancel Apply

2009 Upgrade

Upgrade Contents
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Save an image in JPG format

Upgrade Contents

» Graphic data of the Model Window can be saved in JPG format as well as AutoCAD DXF, BMP or EMF.

File > Graphic files > JPG files

Save As

Save in: I I3 analysis

File name: I G ave

Save as type: |Jpo Files [7.jpa] ;I Cancel

Chwg Files [7.dwag]
AllFiles [*.1)
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Addition of an export option in result tables

Upgrade Contents

* New feature that can export databases to an Excel Spreadsheet.

Results > Result Tables

4 ':i Model \n'iew/y‘:iil Result-[Beam Force] IGANREE IR RS )= Beam Forceads - Microsoft Excel - ax

B Load cart Aoial Shear-y Shear-z Taraten Momert-y Momert-z = Home | Insert Pagelayout  Formulas Data Review  View @ - = X
dtonf) itonif) itonf) ttonf-m) ttonf-m) (tonf-m) % | (oo o - aalE S Genel - | [jconditional Formatting - | Jimsert = % - A

| 1 cLCE 1] 0.00 0.00 = oo = 0.00 Ea - |8 - % | EEFormatasTable - o petete - | (3]~ Z

] 1 eLCB1 J3] 0.00 0.00 Copy 000 Pate g |[B £ U -f|ii-|| &~ A - o 155 Cel styes - i Famat || G~ Fiters oo~

| 2 cLCBEl I[3] 0.00 0.00 0.00 Clipboard = Font F G| MNumber = Styles Cells Editing

| 2 eLCBl J4] 0.00 0.00 % Find.. Chrl+F 0.00 [ ) - A1

] 3 cLCB 4] 0.00 0.00 0.00 3 c o " « . " N ° - =

— 3 ELEEN JI5] Wiy Wiy Sc:rting Dialcn;. o 0w 1 Beam Force =

4 cLCE 5] 0.00 0.00 0.00 - -

e & S J] o o Stvle Dial 000 Axial Shear-y Shear-z Torsion Moment-y Moment-z

— Ie Lalag. . 2 Elem Load Part (tonf) (tonf) (tonf) (tonf-m) (tonf-m) (tonf-m)

] 5 cLCE (3] 0.00 0.00 0.00 5 Jecer i H 7 i s =5 B

| 5 cLCB1 J71 0.00 0.00 Show Graph. .. e T 3 7 == e = 7

| 6 cLCB1 1171 0.00 0wy =R 2ccer i3l 0 0 5.75 “0.04) 8.25 0

1 1§ ELEEA JIE] woig woig Activate Records. . Ay 6| 2l ial 0| 0 5.65 ~0.04) 7.84) 0

| 7 el L) 0wy 0wy / U 7 slacer ifa) 0 o 5.7 [} -8.03 [}

] 7 cLCE Jz2] 0.00 0.00 Export to Excel... / 0.00 - ccel ) & 7 = 3 5.02] 0

| 5 cLCE 9] 0.00 0.00 0.00 z cer |iis) 3 7 = 3 203 0

| 8 cLCB J10] 0.00 0.00 View by Load Cases... 0.00 10 icel  |is] 0 0 5.7 i -8.03 i

| 9 eLCB1 I110] 0.00 0.00 . 0.00 11 81 [ie) 0 0| =7 0 -8.02 0

| aclem 1) 0.00 0.00 Wiews bry Maix Value Item..., 0.00 = e o o 57 o “5.03 o

] 10 cLCE I11] 0.00 0.00 T En] ELH 0.00 12 e1 i 0 o 5.65 0.04 734 o

] 10 cLCE J1z] 0.00 0.00 76 -0 1057 0.00 14 __oefCBL 8] 0 ) 5.75) 0.04 8.5 0

] 11 cLCE I12] 0.00 0.00 7T 0.00 1082 0.00 15 Zlecer [ifm 0 0 _5.82 -0.02] -8.14 0

] 11 cLCE J13] 0.00 0.00 7T 0.00 1082 0.00 16 7lecer ur2g [ o 5.58] -0.02] .22 0

| 12 cLCB1 I[13] 0.00 0.00 -7.26 0.00 -10.587 0.00 17 8|cLCB1 1[9] 0 0| -6.64] 0| -7.73 0|

] 12 cLCE J14] 0.00 0.00 728 0.00 1062 0.00 18 8lclcBl  |J10] 0 0 7.9 0 -12.72 0

] 13 cLCE1 I[14] 0.00 0.00 X -am a1z 0.00 19 9lcicel  [i[10) 0 o -7.66 0.01 -12.19) 0

| 13 cLCB1 Js] 0.00 0.00 7 BB -0.01 -1249 0.00 20 9|clCB1  |J[11] 0| 0 6.88] 0.01 -9.12 0

] 14 cLCE1 I15] 0.00 0.00 7a0 -0 1272 0.00 21 10/clCB1  [I[11] 0 o -7.28| 0 -10.62 0

| 14 cLCE1 JI1E] 0.00 0.00 664 -0 773 0.00 2 10/clCBL _ |J[12] 0 [ 7.26 0 -10.57 0

] 15 cLCE1 I17] 0.00 0.00 X -0 773 0.00 23 11jclCBL  |I[12] 0 o -7.27 0 -10.62 0

] 15 cLCE1 Jig] 0.00 0.00 7.90 -0 1272 0.00 24 11jclCBL _|J[13] 0 o 7.27) 0 -10.62 0

| 16 cLCE 18] 0.00 0.00 -7 66 -0.01 1213 0.00 Z 3 T T g 4 =25 4 =L 9 =

16 cLCE1 Jg] 0.00 0.00 685 -0 a1z 0.00 R 4 » ¥ | Beam Force, Sheets , Sheetd . #d - ol | - — 0
TF [\ Beam Force / I« e [ EEEETTRE Y o
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Export frame model to solid/plate model

Upgrade Contents

» Tendon Profiles as well as concrete girder can be exported to midas FEA for detail analysis.
» Exporting frame model to plate model in midas FEA is newly implemented.

| Effects & Usage

» The user can easily generate the solid/plate model with tendons, which will be analyzed in midas FEA.

File > Export > Frame Section for Solid, Frame Section for Plate

[midas Civil: line beam model]

S
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[midas FEA: Imported tendons]

XK
a7A"
e

[midas FEA: Solid model]
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Improvements in Beam Wizard

» Span-oriented input type for Beam Wizard is newly implemented.
Model > Structure Wizard > Beam

Beam Wizard

Input/Edit | Insert |

Input Tvpe

* Typel i Typez

Ho. X Coord.

0
3

5

10

Distances: Ii, 2,5,8 33 5

{Example : 5, 3, 4.5, 3@5.0)
Add |
Delete |
Delete Al I

[~ Auko Bound, Condition
[~ Show Element Mo,

Makerial

Section

1: Main Girder

|1 a3 ;|_|
i

Fedraw & Update Data

2009 Upgrade

Upgrade Contents




